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Tips and advice to help beginners get started with Adobe Photoshop Elements, plus tutorials for 
learning about the tools and interface of Adobe Photoshop Elements. Explore these basic tutorials 
before moving on to more advanced projects and techniques. 
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Let's start by getting to know the Photoshop Elements workspace. Early versions of Photoshop 
Elements had a user interface very similar to Photoshop. Since version 3, it's changed quite a bit, but 
the two still share many tools and features. Throughout this tutorial, I'll be working with Photoshop 



Elements 4. Users of Photoshop Elements 3 should be able to follow along but there are a few things 
that might be slightly different in that version.  

When you first start Photoshop Elements Editor with the default preferences, you should see 
something like the screen shot here. If the workspace looks vastly different to you, you'll want to reset 
your preferences back to default settings. To do that in Photoshop Elements, hold down Ctrl-Alt-Shift 
(Win) or Command-Option-Shift (Mac) immediately after launching Photoshop Elements Editor, then 
answer Yes when asked if you want to delete the settings file.  

If you get the welcome screen when you launch Photoshop Elements, click the option to Edit and 
Enhance Photos to open the Editor.  

My screen shot shows the Windows version of Photoshop Elements. If you are using a Macintosh, the 
basic layout will be the same, although the style may appear slightly different.  

These are the main counterparts of the Photoshop Elements workspace:  

1. Menu Bar  
2. Shortcut Bar  
3. Toolbox  
4. Tool Options Bar  
5. Palette Bin  
6. Photo Bin  

You can explore each one of them in more detail on the following pages.  
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The menu bar consists of nine menus: File, Edit, Image, Enhance, Layer, Select, Filter, View, Window, 
and Help.  

You may notice that some menu commands are followed by ellipses (...). This indicates a command 
that is followed by a dialog box where you can enter additional settings. Anytime input is needed from 
the user, it is presented in a dialog box. Some menu commands are followed by a right pointing 
arrow. This indicates a submenu of related commands. Create a New Photoshop Elements Document 
You will need to navigate a menu, submenu, and dialog box in order to open a new, blank file.  

1. Click File in the Menu Bar and then New, and then the "Blank File..." command.  
2. The new document dialog box opens. The default settings are for a 5x7 image at a resolution of 

72 in RGB color mode, and a white background.  
3. Click OK in the new document dialog to accept the default settings. You'll need an open document 

to explore the menu commands.  

Take a few moments now to look at each of the menus, starting with the File Menu. As you explore 
each menu, be sure to take a look at the submenus as well. You'll also notice that many commands 
are followed by keyboard shortcuts. Gradually, you'll want to get to know these keyboard shortcuts as 
they can be incredible time savers. As you make your way through this course, you'll be learning the 
most useful keyboard shortcuts as you go.  

Throughout this course, I will use the following syntax for instructions which involve navigating menus 
in Photoshop: File > New > Blank File.  

To the far right of the menu bar, you will have a help search box. Anytime you need help with a task 
in Elements, you can type your search here to quickly access the Help system. 
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Below Photoshop Elements' menu bar is the shortcut bar. The shortcut bar provides buttons for 
accessing some of the most frequently used commands and features in Photoshop Elements. If you 
hold your mouse over each of the buttons on the shortcut bar, a pop-up "tool tip" will appear showing 
the function of the button. Some of these tool tips have blue underlined text to indicate a link. When 
you click these links, they will open the Photoshop Elements Help page for the particular function.  

From left to right, the shortcut bar buttons are:  

• New - opens a new, empty document.  
• Open - browse your computer folders for a file to open  
• Save - saves the active document  
• Print - opens the print preview dialog  
• Email - launches the Organizer component, and then opens the Attach to E-mail dialog.  
• Undo - step backward through any actions you have performed.  
• Redo - step forward through any actions you have undone. Only available after undo has been 

used.  
• Create - launches the Organizer and opens the Creation Setup wizard.  
• Photo Browser - launches the Organizer component of Photoshop Elements.  
• Date View - launches the Organizer component of Photoshop Elements in Date View Mode.  
• Quick Fix - switches to the quick fix mode of the editor, which we'll cover in a future lesson.  
• Standard Edit - This is the mode you're in now. Used for switching from Quick Fix Mode.  

 

The Photoshop Elements Toolbox 

Lesson 1: Getting Around in Photoshop Elements 4 
 



 
The Photoshop Elements toolbox is the tall, narrow palette that sits along the left edge of the 
workspace. The toolbox contains many of the tools you will be working with in Elements. That makes 
it pretty important! (Your screen probably shows the toolbox in a single column like the default 
workspace screen shot. I'm just showing it here in two columns to save space.)  

If you're new to Elements, it's very helpful to have a printed toolbox reference. If you'd like to make 
your own, you can do so by typing "About the toolbox" into the help search box to the right of the 
menu bar, and printing the resulting help page. Keep this printout handy so you can refer to it 
throughout these lessons.  

When you look at the toolbox, notice how some of the buttons have a tiny arrow in the lower right 
corner. This arrow indicates that other tools are hidden under that tool. To access the other tools, click 
and hold down on a button and the other tools will pop out. Try this now by clicking on the rectangle 
marquee tool and changing to the elliptical marquee tool.  

Now hold your cursor over one of the buttons and you should see a tool tip appear that tells you the 
name of the tool and its keyboard shortcut. The rectangle and elliptical marquee tools have a shortcut 
of M. When multiple tools share the same shortcut key, you can press the key multiple times to switch 
between all tools that share that shortcut. So if a marquee tool is not already active the M key will 
switch to it. Once a marquee tool is already active, the M shortcut will toggle between the rectangular 
and elliptical marquee tools. Another shortcut for cycling through the hidden tools is to Alt (Win) or 
Option (Mac) click on the toolbox button. You can also switch between similar tools from the tool 
options bar.  

Take a few moments now to familiarize yourself with the tool names using the tool tips. You'll notice 
that every tool in the toolbox has a link in its tool tip. Feel free to click these links to learn more about 
each tool from Photoshop Elements built-in help. Use the shortcuts you've just learned to explore all 
the hidden tools. Don't worry about using each tool for now; we'll get to that soon enough. For now, 
you should just get to know the tool locations and their icons.  
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If your screen size is tall enough, you can switch the Photoshop Elements toolbar from one column 
docked on the left side of the workspace, to a floating toolbox with two columns. (If your application 
window is less than 750 pixels in height, the toolbar will be in two columns regardless of whether it is 
docked or floating.)  

If toolbar is docked, you will notice a small dotted line at the top of the toolbox. This dotted line is like 
a handle. Just click the little dotted line "grabber" at the top and pull it away from the side of the 
window. When you release the mouse button, the toolbox will float where you drop it. You can move it 
anywhere you want on the screen (including outside of the application window) but if you drop it 
within about a half inch of the left edge of the Elements window it will go back to a docked toolbar.  

To get it back to a single row, just drag it close to the left edge of the screen and you'll see a shaded 
outline appear. Let go and it will dock back to a single row on the edge.  

The toolbox can only be docked on the left edge of the screen. 
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Moving down in the toolbox, we come to the color well. This is where the foreground and background 
colors are displayed.  

• The foreground color is used when you paint, fill, and stroke selections.  
• The background color is used when you make gradient fills, to fill in the erased areas of an 

image, and when you expand the canvas.  
• Foreground and background colors are also used by some special effects filters.  

The small double arrow at the top right of the color well allows you to swap foreground and 
background colors. The tiny black and white swatch symbol to the lower left allows you to reset the 
colors to the default colors of black foreground and white background. Hold your cursor over those two 
areas to learn the keyboard shortcuts. To change a color, simply click on either the foreground or 
background color swatch and select a new color in the color picker. Experiment by changing the 
foreground and background colors and then resetting them back to defaults. 
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Below the Photoshop Elements shortcut bar is the tool options bar. This toolbar is context-sensitive, 
meaning that it changes according to which tool you have selected. Click on a few different tools in the 
toolbox and note how the options bar changes. You can peruse the options for each tool if you like, 
but I'll cover the options for each tool in detail as we learn the individual tools in future lessons.  
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Along the right edge of the screen is a group of palettes called the palette bin. In the default 
workspace the palette bin contains the How To, Styles and Effects, and Layers palettes.  

Each palette is divided by a small border with another "grabber" handle like the one on the Toolbox. 
By clicking and dragging on this divider bar, you can adjust the height of each palette.  

Just to the left of the palette bin is another divider bar. You can click and drag on this divider bar, to 
make the palette bin wider or narrower. You can also double click on the divider bar to temporarily 
slide the palette bin out of the way and make more room to see your document. To bring the palette 
bin back into view, just drag the divider back out or double click on it again. You can also close an 
open the palette bin from the small arrow at the bottom of the screen, below the palette bin.  

On the left side of the title bar for each palette in the palette bin, you will see a small triangle. Clicking 
on this triangle will close the palette but leave its title bar visible in the palette. To display the palette 
again, just click the triangle and it will slide back out to full size.  

On the right side of the palette title bar is a "MORE >" label. Clicking here opens the palette's menu. 
Each palette menu contains options specific to that particular palette. For instance, if you click the 
palette menu for the Styles and Effects palette, you can change from thumbnail view to list view and 
back again. The Layers palette menu will show options specific to working with layers, and so on.  

You can shuffle the stacking order of the palettes in the palette bin by clicking on the title bar and 
dragging up or down within the palette bin. You can float any of the palettes by clicking its title bar 
and dragging it away from the palette bin.  
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Now go to the Window menu and you will see that there are several additional palettes not shown in 
the default workspace. These are: Color Swatches, Histogram, Info, Navigator, and Undo History. 
When you select these from the Window menu, they will open as floating palettes.  

A floating palette has a standard title bar with a minimize and close button. You can expand and 
collapse a palette either by clicking its minimize/maximize button, or by double clicking in the title bar 
or the title tab area of the palette. When a palette is floating you can resize it by clicking and dragging 
on the edges, or the lower right corner of the palette. (Some palettes, like Info and Histogram, cannot 
be resized.)  

To put a floating palette back into the palette bin, click on its title tab and drag it back to the palette 
bin.  



One option in every palette menu is "Place in palette bin when closed." When this option is checked, 
the floating palette will go to the palette bin when you click the X to close it. Otherwise the palette will 
be closed and you will have to go to the Window menu to bring it back.  

When palettes are floating in Photoshop Elements, you can also group multiple palettes together, and 
join them. (Note: The Histogram and Info palettes in Photoshop elements can be grouped, but not 
joined.)  

• To group multiple palettes, drag the title tab of one palette onto another. To bring a grouped 
palette to the front of the group, click on the palette's tab.  

• To join two palettes, drag the title tab of one palette to the bottom edge of another palette. 
When you see a thin rectangle border along the bottom edge of palette, release the mouse 
button. The two palettes will become attached, but not overlapping. You can adjust the height of 
each palette group by dragging the divider between them.  

• To separate the palettes, click on the tab title and drag it out of the group.  

Practice showing, hiding, moving, and resizing the palettes as much as you like. When you're finished 
rearranging your workspace, go to Window > Reset Palette Locations to tidy everything back up again. 
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The Photoshop Elements Photo Bin 

To explore the Photo Bin, you'll need to have some files open. Go to the Shortcut Bar and open two or 
more images. The Photo Bin shows thumbnails of all the files you have open in the workspace. Below 
each thumbnail is the file name. When you click on a thumbnail in the Bin, that file becomes the active 
document in your workspace.  

Like the Palette Bin, there is a divider at the top of the Photo Bin which you can use to resize or hide 
the Bin. There is also a button in the status bar, just below the Photo Bin, which you can use to toggle 
the Bin off and on. The status bar also displays the number of files you have open, and it displays 
some arrows for cycling through the open files.  

That's not all there is to the Photo Bin; you'll find some other interesting options when you right click.  

A right click in a blank area of the Photo Bin shows a menu with the following options:  

• Photo Bin Help - Opens Elements built-in Help to the section on the Photo Bin. Take a moment 
to read more about the Photo Bin here.  

• Help Contents - Provides quick access to the online Help file.  
• Show File Names - Allows you to choose whether you want file names displayed in the Photo 

Bin. Turning off file names will allow more room for thumbnails.  
• Auto Hide - Enabling Auto Hide will cause the Photo Bin to collapse after a few seconds when 

your mouse is not over it. This is useful when you want as much space as possible for your 



workspace. To show the Photo Bin when it's in Auto Hide mode, either click the divider bar or the 
Photo Bin toggle on the status bar.  

A right click on a thumbnail in the Photo Bin shows a menu with the following options:  

• Close - Closes the file corresponding to the thumbnail. If the file has been modified, you will be 
prompted to save.  

• Minimize - Hides the file corresponding to the thumbnail. The file is still open but will not be 
visible in the work area.  

• Restore - Shows a file that has been hidden by the Minimize option. You can also simply click the 
thumbnail to restore a minimized file.  

• File Info - Opens a dialog box which will allow you to read and edit the metadata information 
that is stored in the file. See Metadata in the Graphics Glossary.  

• Duplicate - Makes another copy of the file, allowing you to specify a file name for the copy.  
• Rotate 90° Left - Turns the image to the left.  
• Rotate 90° Right - Turns the image to the right.  
• Show File Names - Same as above.  
• Auto Hide - Same as above. 
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Document Window Elements 

While you have some document windows open in Elements, lets explore some of the document 
window elements. If your image is small, drag the lower right corner of the document window to make 
it large enough that you can see all parts of the document window shown in the diagram above.  

The Title Bar 

The title bar shows the filename, the zoom level, and the color mode of the image. On the right are 
the minimize, maximize/restore, and close buttons that are standard in all computer applications.  

Scroll Bars 

You're probably familiar with scroll bars for moving around the document when it is larger than the 
workspace. A good shortcut to know for avoiding the scroll bars, is the Spacebar on your keyboard. No 
matter where you are in Photoshop, you can temporarily switch to the hand tool by pressing the 
Spacebar. We'll practice this shortly.  



Context-Sensitive Menus 

In addition to the menu bar, Photoshop often has context-sensitive menus for accessing some of the 
most likely commands depending on which tool is selected and where you click. You access the 
context sensitive menu by right clicking, or by pressing the Control key while clicking on a single-
button Macintosh mouse.  

One of the most convenient contextual menus can be accessed by right clicking on the title bar of a 
document for quick access to the duplicate command, image and canvas size dialogs, and page setup. 
Go ahead and try this now on your open document.  

Next select the zoom tool from the toolbox, and right click anywhere inside your document. This 
context-sensitive menu offers quick access to commands for Fit on Screen, Actual Pixels, Print Size, 
Zoom In, and Zoom Out.  

Note: Each document appears in its own floating window, unless you maximize the document window, 
in which case only the top-most document will be visible in the workspace. When you maximize a 
document window in Elements, the document title bar merges with the Photoshop Elements 
application title bar, and the zoom indicator and status bar go to the bottom edge of the workspace, 
above the Photo Bin. 

 

Document Window Status Bar 
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The Zoom Level Indicator 

Located at the lower left corner of the document window, the zoom indicator shows the magnification 
level of the document. You can swipe your cursor in here and type a new number to change the zoom 
level. Go ahead and try it now.  

To return your document to 100% magnification, locate the zoom tool in the toolbox and double click 
the button. The keyboard equivalent to this shortcut is Ctrl-Alt-0 (Win) or Cmd-Option-0 (Mac).  

 



Status Bar 

To the right of the magnification display on the status bar, you will see the document dimensions 
displayed. This shows the print size of the file and its resolution.  

Status Bar Display Options 

Next to the Document sizes display there is a small black arrow that pops up a menu. This menu 
controls what is shown in this area of the status bar. In addition to Document Dimensions, you can 
optionally choose to display Document Sizes, Document (Color) Profile, Scratch Sizes, Efficiency, 
Timing, or the name of the current tool. To learn more about each of these items, look up "To display 
file information in the Info palette or status bar" in Photoshop's online Help.  
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I mentioned already that you can use the Spacebar on your keyboard to temporarily switch to the 
hand tool at any time. To practice this:  

1. Open an image and drag the borders of the document window so it is smaller than the image.  
2. Press the Spacebar and click on the image.  
3. While holding the Spacebar down, move the mouse around to move the image around within the 

window.  

We don't need no stinkin' scroll bars! Another handy shortcut is to double-click on the hand tool in the 
toolbox to quickly fill the available workspace with your image. This will set the magnification level to 
whatever size it needs to be to make the image fill the screen. Check the title bar or the status bar to 
see what the actual magnification level is.  

While you have the hand tool active, take a look at the options bar for the hand tool. You'll notice 
three buttons there for Actual Pixels, Fit Screen, and Print Size. These same options are also available 
from the context sensitive menu when you right click with the hand tool active. Do you remember 
these from the zoom tool's context sensitive menu?  

• Actual Pixels shows the image at 100% magnification.  
• Fit Screen scales the image to fit inside your workspace. This may make the magnification 

higher or lower than 100% depending on the size of the image and your screen resolution and 
workspace layout.  

• Print Size approximates the size that the image will be when printed, taking resolution into 
account. Since all monitors vary, this should only be considered an approximation. Well learn 
more about resolution later.  

Since these options are also available in the Zoom tool, and now that you know the Spacebar trick, 
there is very little reason you'll ever need to use the hand tool from the toolbox! 
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Now select the Zoom tool in the toolbox. Notice the same three "fit" buttons in the options bar, just 
like the hand tool. If you want the document window to resize as you zoom in and out, check the 
"Resize Windows to Fit" box on the options bar. You've already learned a few different ways to change 
the magnification of your image--the zoom control in the status bar, the context-sensitive menu, and 
double clicking the zoom tool. Let's look at a few more.  

When the zoom tool is selected, the cursor becomes a magnifying glass with a plus sign. The plus sign 
indicates that you're all set to zoom in. All you need to do is click to increase magnification. If you 
want to zoom in on a specific area of the image click and drag a rectangle around the area you want 
to magnify. This will enlarge the selected area to fill the workspace. Try it now. To return to 100% 
magnification, use the keyboard shortcut, Ctrl-Alt-0 (Win) or Cmd-Option-0 (Mac). To zoom in 
without switching to the zoom tool, use Ctrl-+ (plus sign) on Windows or Command-+ (plus sign) on 
Macintosh.  

To switch to zoom out mode, you can click the zoom out button on the options bar. However, it is 
much easier to use the keyboard shortcuts. When you hold down the Alt (Win) or Option (Mac) key, 
the zoom cursor will change to a minus sign in the magnifying glass, and you can click to zoom out. 
To zoom out without switching to the zoom tool, use Ctrl-- (minus sign) on Windows or Cmd-- (minus 
sign) on Macintosh.  

Let's review each of the zoom tool options:  

• No modifier key = click to zoom in; click and drag to zoom into a specific area  
• Double click zoom tool button = zoom to 100% magnification  
• Ctrl-Alt-0 (Win) / Cmd-Option-0 (Mac) = zoom to 100% magnification  
• Alt (Win) / Option (Mac) = click to zoom out  

Here are a few more zoom shortcuts we have not yet covered:  

• Ctrl-0 (Win) / Cmd-0 (Mac) = zoom to fit the screen  
• Ctrl (Win) / Cmd (Mac) = temporarily toggles to the move tool  



Working in Photoshop Elements generally involves a lot of zooming and panning, so now you are well 
on your way. By memorizing the most common keyboard shortcuts related to zooming and panning, 
these functions will become second nature to you and you'll be able to work much faster.  

 

Photoshop Elements: Lesson 1 Review 

"Getting Around Photoshop Elements " 

 

It may not seem like we have covered very much so far, but you may be surprised at what you've 
learned. Let's review what we have studied in Lesson 1: Getting Around Photoshop CS2  
•  You learned how to find hidden menus and tools when you see a small arrow on a menu, palette, or 
tool button.  
•  You learned how to identify many of the most commonly used keyboard shortcuts.  
•  You learned how to take advantage of tool tips to find your way around the toolbox.  
•  You learned how to open a file.  
•  You learned how to change the foreground and background colors, swap colors, and reset colors to 
defaults.  
•  You learned how to move, arrange, group, hide and show the palettes and bins.  
•  You learned how to access additional palette options through the palette menu.  
•  You learned how to customize palettes and move them in and out of the palette bin.  
•  You learned how to pan a document with the hand tool.  
•  You learned several ways to zoom in and out of documents.  
Let's review each of the keyboard shortcuts and commands we've discussed so far:  

Zoom shortcuts:  

• No modifier key = click to zoom in; click and drag to zoom into a specific area  
• Ctrl-+ (plus sign) (Win) / Cmd-+ (plus sign) (Mac) = zoom in  
• Double click the Zoom tool = zoom to 100% magnification  
• Ctrl-Alt-0 (Win) / Cmd-Option-0 (Mac) = zoom to 100% magnification  
• Double click the Hand tool = zoom to fit the screen  
• Ctrl-0 (Win) / Cmd-0 (Mac) = zoom to fit the screen  
• Alt (Win) /Option with zoom tool = click to zoom out  
• Ctrl-- (minus sign) (Win)/ Cmd-- (minus sign) (Mac) = zoom out  
• Type any number into the status bar magnification level display. 

Opening a File:  

• File > Open  
• Ctrl-O (Win) / Cmd-O (Mac)  
• Click the Open button on the Shortcut Bar 

Other Shortcuts:  

• D = resets the foreground color to black and background color to white.  
• X = swap foreground and background colors.  



• M = marquee tool  
• Shift-M = toggle rectangular and elliptical marquee tools 

 

REMEMBER 

This tutorial is not free of cost  , It is provided only on pray for me and my family. 

THANK YOU  

May allah bless all of you. 

ASIF WASI SIDDIQUI  

 

 

 


